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Resumen. 

En el presente trabajo se presenta una metodología para la modelación de engranajes 

cónicos de dientes rectos en AutoCAD y la posterior simulación de la resistencia a la 

flexión de los dientes empleando el método de elementos finitos en Ansys. Esta 

metodología es aplicada a la determinación de las tensiones y la resistencia en un engranaje 

perteneciente a la máquina pestañadora utilizada en el proceso de fabricación de cilindros 

de gas en la empresa Conformat Noel Fernández. Finalmente, se obtuvo un modelo que 

relaciona los esfuerzos surgidos en el pie del diente producto las fuerzas que se generan 

durante el contacto de engranajes cónicos, con el módulo y el coeficiente de corrección. 

Palabras claves: engranajes cónicos, elementos finitos, simulación, bevel gears, FEM 

1. Introducción 

Las transmisiones por engranajes son los mecanismos de mayor auge en el mundo 

contemporáneo, siendo utilizadas en un gran número de aplicaciones, desde piezas de gran 

tamaño, como las masas de los centrales, hasta piezas muy pequeñas como las 

transmisiones de relojes, y siendo empleado en máquinas de gran responsabilidad 

(González y Alfonso, 2006; González  y González, 2012; González y Peña, 2012).  

Su importancia ha hecho de este campo, uno de los más investigados en la rama mecánica. 

No obstante a ello, debido a su complejidad aún quedan muchas incógnitas por resolver por 

los especialistas y estudiosos del tema. 

Obtener transmisiones con dimensiones mínimas que aseguren su resistencia, se ha 

convertido en una premisa en la actualidad, lo cual ha obligado a buscar diversas 

alternativas para ello. 

El desarrollo de la computación en los últimos años, ha posibilitado la utilización de 

herramientas y métodos matemáticos para la solución de diversos problemas ingenieriles, 

en los cuales se haría muy difícil obtener los resultados de forma manual. Es por ello, el 

auge que ha experimentado en los últimos años el método de elementos finitos, el cual ha 

permitido resolver una gran diversidad de problemas. 

Varios trabajos investigativos han sido desarrollados por González et. al. (2005), 

Ural et. al. (2005) Mirabet y Martínez (2006), González (2007), González y Marrero 

(2008), Liang y Xin (2013) encaminados a la solución de problemas relacionados con 

engranajes cónicos, empleando diferentes técnicas computacionales. 

De acuerdo con Liang y Xing (2013), empleando técnicas computacionales como el método 

de elementos finitos se pueden realizar estudios relacionados con el funcionamiento de los 

engranajes, las fuerzas y tensiones generadas durante el contacto, así como los posibles 

deterioros que pueden traer consigo. 

 



2. Transmisiones por engranajes cónicos 

Existe una gran variedad de transmisiones por engranajes, y por tanto numerosas 

clasificaciones, sin embargo las más abordadas en la literatura son de acuerdo a la forma 

geométrica del cuerpo y al tipo de dientes. De acuerdo a su forma pueden ser transmisiones 

por ruedas dentadas cilíndricas, cónicas y por tornillo sin fin y los tipos de dientes más 

empleados son los rectos, helicoidales y bihelicoidales (o de chevron), aunque existen 

otros. Sin embargo, los engranajes cónicos de dientes rectos han sido menos estudiados 

(González, 2001; González y González, 2012). 

Los engranajes cónicos son empleados para transmitir movimientos entre ejes concurrentes, 

permitiendo realizar cambios de dirección de movimiento o variación de la velocidad de 

rotación entre los árboles en los cuales acoplan. 

En los engranajes cónicos los niveles de transmisión de potencia y rendimiento son 

similares a los cilíndricos, pero admitiendo mayores velocidades por una continuidad 

mayor en el engrane. 

3. Metodología para el cálculo geométrico de engranajes cónicos 

El engranaje cónico se emplea para transmitir el movimiento entre árboles que se 

interceptan. El ángulo de intercepción de los árboles puede ser cualquiera, en la mayoría de 

los casos se usa el recto. 

En los engranajes cónicos de dientes rectos, al igual, que en los cilíndricos la relación de 

transmisión puede calcularse empleando tanto la relación de velocidades angulares entre la 

rueda conductora y la conducida, como la relación entre los radios primitivos de estas. 

También puede ser determinada a través de la relación entre el seno del ángulo del cono 

primitivo del piñón y la rueda (Baranov, 1979). 
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En la figura 1 pueden observarse los parámetros geométricos fundamentales en ruedas 

cónicas de dientes rectos. 



 

Figura 1: Parámetros fundamentales de las ruedas dentadas cónicas. 
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Radio de la circunferencia de la cabeza del diente 
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Radio de la circunferencia del pie del diente 
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Donde: 

m - Módulo 

δ -  Ángulo de conicidad. 

i12 – Relación de transmisión del par engranado 

Z1 – Número de dientes de la rueda conductora 

Z2 – Número de dientes de la rueda conducida 

4. Fuerzas que actúan en los engranajes cónicos. 

De acuerdo con Dobrovolski et. al. (1980), en los engranajes cónicos de dientes rectos, la 

fuerza de contacto normal se descompone en tres componentes fundamentales: 

 Fuerza tangencial o circunferencial 

 Fuerza radial 

 Fuerza axial 

El esfuerzo circunferencial, en el diámetro medio de la rueda cónica se determina por la 

relación existente entre el momento torsor y el diámetro primitivo de la rueda de acuerdo 

con la siguiente expresión (Dobrovolski et. al., 1980): 
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Donde M1 es el momento torsor en el árbol donde se encuentra montado el engranaje y d1 

el diámetro primitivo del piñón. 



El esfuerzo radial en el diámetro medio se determina en función de la fuerza tangencial y el 

ángulo de presión del engranaje. 

 tgFF Tr  
22 

Descomponiendo esta  fuerza en dos direcciones paralelamente a los ejes de la ruedas. El 

esfuerzo radial sobre el árbol conductor es:  

11 cos  tgFF Tr  
23 

El esfuerzo axial en el árbol conductor es igual a 

11  sentgFF Tx   24 

Por su magnitud, el esfuerzo radial en el árbol conducido es igual al esfuerzo axial en el 

árbol conductor, en las direcciones de estos esfuerzos son opuestas: 

12 xr FF 
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Análogamente  

12 rx FF 
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Por los esfuerzos hallados xr FFF ,,  se calculan las reacciones de apoyo y luego se 

determinan las dimensiones de los árboles de la transmisión y de los cojinetes. Para 

disminuir las magnitudes de los momentos flectores es necesario el piñón lo mas cerca 

posible de los cojinetes. 

Sobre los árboles del engranaje cónico de dientes oblicuos, además de las  componentes del 

esfuerzo radial rF  actúan las componentes del esfuerzo axial xF  cuyo valor se determina 

según la formula: 

mTr tgFF 1  27 

Donde m es el ángulo de inclinación de dientes en el diámetro medio del piñón 1md . 



A continuación se trasladan estas fuerzas rF  y xF  al polo de engranaje sobre el diámetro 

medio de las ruedas cónicas y  se descomponen en dos direcciones perpendiculares a ejes 

de las ruedas cónicas. Sumando las componentes de los esfuerzos, se obtiene el esfuerzo 

radial en el árbol conductor  y el esfuerzo axial.  

111 cos  mx tgFsentgFF
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Si en las dos últimas igualdades se saca 1Fsen del paréntesis  y se tiene en cuenta que al 

variar la inclinación de los dientes cambia la dirección del esfuerzo axial, entonces para el 

caso común obtenemos: 

);(11 mr tgtgusenFF  
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Estas son las fuerzas que actúan durante el contacto de los engranajes, y las mismas son 

consideradas posteriormente durante el diseño y análisis de resistencia. 

5. Corrección en transmisiones por engranajes. 

Para comprender a cabalidad este fenómeno es necesario remontarse a dos conceptos 

básicos: Cremallera básica y propiedades de la evolvente. A continuación  se abordan los 

mismos de manera simplificada. 

Se denomina cremallera básica al patrón que establece las principales dimensiones 

geométricas de una transmisión por engranajes, y de hecho determina la forma del diente. 

Por ejemplo una fresa madre  contiene en su sección transversal una cremallera básica. Las 

normas internacionales establecen los parámetros geométricos de la cremallera básica; 

destacándose entre ellos  la recta de módulo o línea de referencia, que es la que divide la 

cremallera  en dos partes, una superior y una inferior. A lo largo de esta línea el espesor del 

diente es igual al del espacio interdental (ver figura 3). Es importante tener en cuenta que la 

cremallera básica tiene determinado ángulo del perfil (llamado ángulo de la cremallera),   y 

que el paso es el mismo por cualquier recta paralela a la recta de módulo o línea de 

referencia (Laureano y Goytisolo, 2000).  

De acuerdo con Laureano y Goytisolo (2000) la esencia de las correcciones del dentado 

consiste en ir ubicando el diente en una zona  de la evolvente diferente a la que le hubiera 

correspondido si se hubiera tallado normalmente. Esta claro  que si deseamos movernos 

hacia afuera por la evolvente el radio del semiproducto debe ser mayor y viceversa. 



Empleando coeficientes de corrección puede ser aumentada la capacidad de carga del 

engranaje y ajustar el montaje de las ruedas engranadas en una distancia interaxial prefijada 

conservando la relación de transmisión cinemática dada. Con ayuda de las correcciones 

positivas en la rueda se puede prevenir la interferencia de los dientes engranados y 

posibilitar el tallado de piñones con número de dientes pequeños sin peligro del socavado 

de sus bases (González, 2001). 

Las correcciones positivas producen un aumento de la resistencia de los dientes a la fractura 

y a la picadura, aunque el efecto favorable de mejorar la resistencia del dentado es más 

significativo en ruedas con pequeños números de dientes. Sin embargo el aumento de los 

coeficientes de corrección pueden conducir a la disminución del espesor del diente cerca 

del vértice y provocar debilidad a la fractura en su cresta, por tal motivo los valores 

máximos del coeficiente de corrección se restringen por las condiciones que pueden 

provocar un tallado puntiagudo de los dientes (González, 2001). 

Mediante la corrección puede aumentar la capacidad portante de los engranajes debido a: 

un aumento del ancho del diente cerca de su base, posibilidad de reducir el número de 

dientes y aumentar respectivamente el módulo, aumento de los radios de curvatura de las 

superficies de evolvente, posibilitar el engrane de varios pares dentados cuando uno de 

ellos pasa por el polo y disminución de la velocidad del deslizamiento (González, 2001). 

De acuerdo con González (2001) se le llama corrección sumaria X  a la sumatoria de los 

coeficientes de corrección de la rueda conductora X1 y de la rueda conducida X2. 
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tttinv   tan  32 

twtwtwinv   tan  33 

Siendo tw  el ángulo de engrane en el plano transversal que puede ser obtenido por las 

siguientes relaciones: 
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Mientras t  es el ángulo del perfil de referencia de la cremallera básica en el plano 

transversal: 
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El ángulo de presión   más recomendado es 20º, aunque para pudieran emplearse otros 

valores para diferentes aplicaciones. 

Es considerado un coeficiente de corrección positivo (x > 0) en caso de un alejamiento de 

la herramienta, en caso contrario se indica un coeficiente de corrección negativo (x < 0). 

6. Modelación de engranajes cónicos en AutoCAD. 

Para aplicar esta metodología se toma como ejemplo un engranaje cónico de dientes rectos 

perteneciente a una máquina pestañadora usada en el proceso de fabricación de cilindros de 

gas en la empresa CONFORMAT Noel Fernández, cuyos datos fundamentales pueden 

observarse como parámetros de entrada en la figura 2. 

El modelo geométrico del par dentado se construye en el programa AutoCAD2000. Para 

ello primeramente es necesario determinar los principales parámetros que caracterizan el 

par dentado, de acuerdo a las expresiones  2-20. Para el cálculo de estos parámetros se 

puede emplear una hoja de cálculo programada en Microsoft Excel (Figura No. 2).  
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Figura 2: Hoja de cálculo para la determinación de los parámetros geométricos. 

Para la obtención del modelo geométrico es necesario realizar el plano de acoplamiento 

piñón-rueda, sobre la base de los datos obtenidos por la metodología expresada por las 

ecuaciones 2 hasta 20, cuyo resultado fue obtenido en la programación en Excel. 

Para ello primeramente se proyectan los ejes x - y en el plano y se comienza el dibujo  

trazando las líneas correspondientes a las generatrices de los radios primitivos y exterior, de 

acuerdo al ángulo que forman con el eje horizontal, el ángulo del cono primitivo y el 

ángulo del cono exterior, con su respectivos radio primitivo y altura de la cabeza y pie del 

diente. Finalmente se completa dibujando la parte restante del piñón.  



 

Figura 3.  Acoplamiento piñón-rueda. 

 

Figura 4.  Plano principal de la rueda conductora. 

 

Figura 5.  Plano principal de la rueda conducida. 



Una vez realizado el dibujo del plano de ensamble piñón-rueda, se procede a la modelación 

tridimensional (3D) del par cónico. 

Para ello primeramente se traza el perfil del diente en la parte trasera del engranaje, 

tomando como base la circunferencia interior, y a través de la intercepción de las 

circunferencias correspondientes a cada parámetro geométrico calculado ri, ro, rp, re y rn 

con los ángulos βo, βp, βn, βe (figura 6). 

 

Figura 6.  Modelación del perfil del diente. 

Fuente: González I y González O. (2013) 

 Los parámetros fundamentales para el trazado del perfil del diente son determinados de 

igual manera a través del programa Excel, mostrado en la tabla a continuación. 

 

Figura 6.  Determinación de parámetros geométricos del perfil del diente en Excel. 



A continuación siguiendo el mismo procedimiento se traza el perfil frontal del diente del 

engranaje. Para ello es necesario calcular los parámetros geométricos de un diente cuyo 

módulo sea igual a la altura de la cabeza del diente en la parte frontal del engranaje. Este 

valor puede obtenerse a través de la medición en el plano bidimensional realizado 

anteriormente. Una vez construido el perfil de ambas caras del diente, es necesario 

convertirlo en polilínea, a través del comando pedit. 

 

Figura 7.  Trazado del perfil anterior del diente. 

Resulta necesario antes de construir el diente de forma tridimensional, dar inclinación 

frontal al diente, con un ángulo igual a δ1. 

Posteriormente se realiza la solevación del diente y del cono base, empleando el comando 

de solevación (loft), obteniéndose la estructura tridimensional de estas partes. Para generar 

el resto de los dientes es necesario realizar un arreglo polar cuya cantidad de elementos sea 

igual al número de dientes, desarrollado en un ángulo de 360º. Finalmente se unen cada una 

de los dientes con el cono base a través del comando union. Para dibujar la rueda 

conducida se sigue el mismo procedimiento, quedando de la siguiente manera: 

 

 

Figura 8.  Dibujo tridimensional final del a) piñón b) Rueda. 



 

Figura 9.  Dibujo tridimensional del ensamble. 

Finalmente se realizan los agujeros y chaveteros, sustrayendo del sólido, cuerpos cuya 

geometría sea igual a la forma de estos elementos. Estas geometrías se obtienen mediante el 

comando extrude y luego son sustraídas  empleando el comando substract. 

7. Metodología para la simulación en ANSYS. 

Para la simulación en Ansys se realiza un análisis estructural estático, con la carga aplicada 

en la rueda conductora del par de engrane, considerando que esta va a estar sometida a 

mayores esfuerzos debido a que presenta un menor número de dientes, en la cual se 

determinan las tensiones generadas en el pie del diente. Se asume las fuerzas provocadas 

por el contacto del par de ruedas sobre el polo de engrane, considerando que en este 

instante ocurre la rodadura pura y que las fuerzas se encuentran repartidas en un solo par de 

dientes. 

Definición del tipo de elemento 

El primer paso a realizar como parte de la etapa de Preproceso, es la definición del tipo de 

elemento. Para ello es necesario acudir al menú principal y seguir la siguiente secuencia: 

Menú principal: Preprocessor > Element Type > Add/Edit/Delete 

El tipo de elemento empleado en el análisis es el Solid187, el cual tiene forma de 

tetraédrico, compuesto por 10 nodos, con comportamiento cuadrático del desplazamiento y 

adecuado para modelar mallas irregulares. El elemento esta definido por 10 nodos con tres 

grados de libertad en cada nodo: desplazamientos en dirección de x, y, z. Presenta además 

capacidad de plasticidad, elasticidad, hiperelasticidad, fricción, grandes deflexiones y 

grandes deformaciones. 



 

Figura 10: Elemento tetraédrico Solid187. 

También tiene mezclada capacidad de la formulación para simulación de materiales 

incompresibles elastoplásticos, y materiales hiperelásticos incompresibles. Los datos de 

entrada del elemento incluyen propiedades del material ortotrópicas o anisotrópicas. 

Propiedades del material. 

El material que compone el par engranado es el acero AISI 1045, cuyas propiedades 

químicas y mecánicas son mostradas en las tablas 2.4 y 2.5. 

Tabla 1: Características químicas del acero AISI 1045. 

Especificación C Mn P S Si 

AISI 1045 0.45 0.60-0.90 0.030 0.035 0.35 

Tabla 2: Propiedades mecánicas del acero AISI 1045 (tomado de www.matweb.com). 

Especificación 

Resistencia a 

la tracción 

(MPa) 

Límite de 

Fluencia 

(MPa) 

Módulo de 

Elasticidad 

(GPa) 

Módulo 

Tangencial 

(GPa)

Densidad 

(g/cm
3
) 

Elongación 

(%) 

AISI 1045 515 485 200 80 7.87 10 

Las propiedades introducidas en Ansys son el Módulo de Young 200000MPa y el 

coeficiente de Poisson 0.3, siguiendo la ruta siguiente: 

Menú Principal: Preprocessor > Material Props > Material Models 

Para el análisis se considera un material cuyas propiedades son lineales, elásticas e 

isotrópicas. 

 



Propiedades del mallado. 

Teniendo en cuenta que se requiere un análisis de tensiones provocadas fundamentalmente 

por las cargas transversales, radiales y axiales generadas durante el contacto de 2 dientes en 

el polo de engrane, y considerando la geometría de un engranaje cónico, se emplea un 

modelo tridimensional correspondiente a una sección de dicha geometría, en la cual se 

considera sólo el contacto de un diente en cada rueda. Ello permite el ahorro de tiempo y 

recursos computacionales durante el análisis. 

El modelo geométrico es creado en AutoCAD, como se explicó previamente, exportado en 

un fichero tipo .SAT e importado posteriormente desde el Ansys. 

Files > Import 

Una vez cargado el modelo geométrico se realiza el mallado del mismo. Para ello es 

necesario establecer los parámetros del mallado, de la siguiente manera: 

Menú Principal: Preprocessor > Mesh > Size Cntrl > Manual Size > Lines 

Teniendo en cuenta la zona donde se requiere analizar los valores de tensiones, se realiza 

un mallado grueso compuesto por 5mm de longitud en cada una de las líneas que 

componen el cuerpo y un mallado fino compuesto por longitud de 0.2mm en las líneas que 

componen el pie del diente, zona donde se requiere una mayor exactitud.  

La región correspondiente al ancho del engranaje fue dividida en 10 partes, para  realizar el 

análisis en cada una de estas secciones. Para la realización del mallado se siguen los 

siguientes pasos: 

Menú Principal: Preprocessor > Mesh > Size Cntrl > Manual Size > Lines 

 

Figura 11.  Mallado del sólido. 



Finalmente el mallado queda compuesto por 32967 elementos y 47740 nodos. 

Condiciones de fronteras. 

Las condiciones de carga se establecen en base a condiciones de restricción de 

desplazamientos y de aplicación de fuerzas externas. 

La restricción de desplazamientos se realiza en las superficies donde fue realizado el corte 

de la sección a analizar. En estas aéreas se restringen los tres grados de libertad posibles 

para este elemento: Desplazamientos en X, Y e Z. 

Debido a la geometría irregular presente en engranajes cónicos, así como la variación del 

radio primitivo a lo largo del diente, es necesario calcular los valores de fuerzas en varios 

puntos a lo largo de la línea donde actúan las mismas (Ver figura 12). Para se divide esta 

distancia en 10 sub-partes, lo cual se establece de esta manera durante el mallado del 

cuerpo. 

 

Figura 12. División de la carga a lo largo del radio primitivo. 

Para calcular la fuerza tangencial que actúa en cada punto se emplea la expresión 38, 

aplicada a cada radio rpi, mostrado en la figura anterior.  

 
38 

Empleando las ecuaciones 21-30 se calculan las fuerzas radiales y axiales presentes sobre 

cada punto. Para realizar estos cálculos se emplea una hoja programada en Microsoft Excel, 

lo cual permite agilizar los cálculos mediante el empleo de técnicas computacionales y 

reducir el posible error humano.  



Para aplicar las cargas al modelo se sigue la siguiente secuencia: 

Menú Principal: Solution > Define Loads > Apply > Structural > Force/Moment > On 

nodes 

Una vez determinado los valores de fuerza en cada nodo es necesario comprobar que la 

sumatoria de momentos generados por las mismas es igual al momento torsor total presente 

en el árbol. Finalmente se resuelve el sistema de ecuaciones de elementos finitos siguiendo 

la siguiente secuencia: 

Menú Principal: Solution > Solve > Current LS 

Post-proceso. 

En esta etapa se determinan los gráficos de tensiones y deformaciones en los nodos y 

elementos que se requieren para el análisis. En este caso se emplean las Tensiones normales 

en dirección de cada una de los ejes, así como las Tensiones de von Mises, cuyos valores se 

pueden obtener en cada nodo de la siguiente manera: 

Menú Principal: General Postproc > Contour Plot > Plot Result > Nodal Solution 

A continuación se selecciona la componente de tensiones o desplazamientos que se desea 

graficar. De igual manera se puede obtener un listado de los valores de tensiones o 

desplazamientos:  

Menú Principal: General Postproc > Contour Plot > List Result > Nodal Solution 

8. Resultados de la simulación de tensiones en el pie del diente. 

Al analizar los resultados obtenidos a través de la simulación por elementos finitos 

(figura 13), se pudo observar que en el pié del diente se obtienen los mayores valores de 

tensiones, y en esta zona es la más propensa al agrietamiento y rotura producto a las cargas 

de flexión.  Durante este análisis es necesario despreciar en los gráficos las tensiones en los 

puntos donde se aplican las cargas debido al principio de Saint Benard.     
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Figura 13. Tensiones de Von Mises en el diente del piñón. 

En la tabla 3 se resumen los estados tensionales surgidos en el piñón, durante el contacto 

del par dentado que forma parte de la variante original de la máquina pestañadora. 

Tabla 3. Estados tensionales surgidos en el piñón. 

Magnitud Valor Unidad 

Tensiones en X -18,8029 MPa 

Tensiones en Y -28,294 MPa 

Tensiones en Z -11,58 MPa 

Tensiones tangenciales en plano XY -17,041 MPa 

Tensiones tangenciales en plano YZ -7,506 MPa 

Tensiones tangenciales en plano XZ -4,567 MPa 

Tensiones de Von Mises 28,99 MPa 



En la componente Y se obtienen los mayores valores de tensiones ya que en esta 

componente influyen con mayor magnitud las fuerzas tangenciales y radiales. Esta 

componente llega a ser de tracción por la parte donde se encuentra en ese momento la 

fuerza y a su vez de compresión hacia el otro lado del diente. A pesar que las tensiones de 

compresión son superiores a las de tracción, estas últimas son más peligrosas ya que las 

mismas tienden al agrietamiento del pie del diente. 

En la figura 3.1 se observa la variación de las tensiones a lo largo del eje del piñón. 

Tensiones vs Distancia

0

5

10

15

20

25

30

35

0 10 20 30 40 50

Distancia a lo largo de eje z (mm)

T
e
n

s
io

n
e
s
 m

á
x
im

a
s
 

(M
P

a
)

Serie1

 

Figura 14. Tensiones máximas en el pie del diente a lo largo de su eje. 

Como ya se ha explicado el módulo tiene una gran influencia en las tensiones en el pie del 

diente. Según se aleje de la parte trasera del diente las tensiones van aumentando, debido a 

que el perfil se va haciendo más pequeño, hasta alcanzar las tensiones máximas en la parte 

frontal, cuyos valores llegan a alcanzar hasta 28,99MPa.   

9. Influencia del módulo y el coeficiente de corrección en las tensiones 
máximas en el pie del diente. 

El modulo y el coeficiente de corrección son dos factores que influyen considerablemente 

en la magnitud de las tensiones originadas en el pié del diente como resultado del contacto 

de dos ruedas dentadas. Por ello se realizan a continuación varias corridas para determinar 

la relación entre estos parámetros en engranajes cónicos de dientes rectos. Para ello se 

emplean como valores de módulo 4, 5 y 6mm y coeficientes de corrección -0.41, 0, 0.41, 

los cuales fueron determinados a través de la expresión 31. 

En la tabla 4 se representan las tensiones máximas obtenidas en cada una de las variantes 

experimentales. 



Tabla 4. Variación de las tensiones en función del módulo y el  coeficiente de corrección. 

Módulo 

(mm) 

Corrección 

(mm) 

Tensión 

Máxima 

(MPa) 

4 -0,41 176,99 

4 0 97,96 

4 0,41 63,54 

6 -0,41 64,44 

6 0 28,99 

6 0,41 20,19 

8 -0,41 25,34 

8 0 14,10 

8 0,41 8,31 

Las tensiones máximas se encuentran en la variante de módulo 4 y coeficiente de 

corrección -0.41, cuyo valor es 176.99MPa, ya que es el piñón mas pequeño de todos lo que 

se encontraban expuestos al experimento. Por otro lado se puede decir que las tensiones 

mínimas se encuentran en la variante de módulo 8 corrección 0.41, cuyo valor fue de 

8,31MPa por su condición de ser el piñón de mayores dimensiones de los sometidos a 

prueba. 
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Figura 15. Variación de las tensiones en función del módulo y el coeficiente de corrección. 

Tal y como puede observarse en la figura 3.3, a medida que se incrementa el módulo, las 

tensiones van disminuyendo y de igual manera a medida que se incrementa el coeficiente 

de corrección disminuyen las tensiones en el pie del diente, por lo cual en ambos casos 

existe una dependencia inversamente proporcional con las tensiones lo cual provoca un 

incremento en la resistencia del diente a la flexión. 



En todas las variantes empleadas durante la simulación, los valores de tensiones máximas 

son inferiores a las tensiones admisibles por el material, lo cual indica que en todos los 

casos el material resiste las cargas a las cuales se encuentra sometido. No obstante, sería 

recomendable realizar otros análisis para comprobar la resistencia a la fatiga y al contacto 

de los pares engranados. 

Estos resultados indican el sobredimensionamiento del par engranado, debido a que el 

mismo fue construido de manera robusta hace varios años. 

10. Conclusiones 

El método de elementos finitos es una herramienta matemática capaz de solucionar 

problemas de gran complejidad, como el caso de la determinación de los estados 

tensionales en engranajes cónicos de dientes rectos. Su aplicación a problemas tecnológicos 

existentes en nuestras industrias, permite obtener resultados con gran precisión en un 

tiempo relativamente corto de tiempo y con ahorro de recursos materiales. 

No obstante, se debe trabajar en la obtención de modelos más eficientes, determinando el 

tamaño y forma óptima para los elementos del mallado, así como la manera de implementar 

las condiciones de fronteras, y el estudio de los modelos de propiedades del material más 

adecuados. 

Así mismo, resulta necesario continuar en el estudio del fenómeno de contacto existente en 

engranajes cónicos, el fenómeno de deslizamiento entre los dientes y las tensiones 

tangenciales alternantes causantes del agrietamiento y fatiga. 
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